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Welcome to the latest edition of my monthly Final Cut Studio newsletter for July, 2009.

The goal of this newsletter is to provide information helpful to the interested user of Final Cut 
Pro. This newsletter publishes each month, past issues are available in my store. All software 
references are to Final Cut Studio 2 unless otherwise noted. 

Please invite your friends to visit my website -- www.larryjordan.biz. There you'll find daily tips, 
the latest industry news, and over 450 articles and tutorials to help you get the most out of 
Final Cut!

NEWSLETTER CONTENTS

�●     Welcome
�●     Major Workflow Revision: Working With Stills
�●     Larry Releases EIGHT New Video Tutorials! 
�●     Review: Dulce Systems Pro Q
�●     A Note On RAID Levels
�●     The Case of The Trapped Data
�●     Spend A Day Learning With Larry
�●     Larry Is Returning To The UK In August! 
�●     Fixing Out-Of-Sync Audio
�●     Make Rendering Go Faster
�●     We Are Worldwide!
�●     Another Point of Voice on a File Organization System
�●     Technical Update: What Is Bit-Depth And Quantization?

PASSING THOUGHTS

�●     Even Toys Are Useful 
�●     Picking a RAID 
�●     Scrolls and Crawls Can't Exceed Two Minutes 
�●     Timecode Calculator 
�●     Amazing Underwater Footage 
�●     Deconstructing Flash Movies 

http://www.larryjordan.biz/index.html
http://www.larryjordan.biz/


READER MAIL

�●     Preparing RAW Images In Photoshop Elements 
�●     Fixing Audio Sync Issues In QuickTime
�●     Making An Audio Insert Edit
�●     Stuttery Audio Playback
�●     Outputting Mono Audio
�●     What's Going On Here?
�●     Getting From Here To There The Hard Way
�●     Exporting HDV For DVD Studio Pro
�●     DVD Subtitle Question
�●     Importing Text Into Final Cut Pro
�●     Scrolling Text Jumps
�●     Soundtrack Pro Keyframes And Envelopes
�●     Getting Centered
�●     Positives and Negatives Of SSD Drives 
�●     Problem With Boot Drive
�●     Picking The Best Codec
�●     Editing Multi-cam
�●     Frame Rendering Explained
�●     External Filter Controls

QUESTIONS LARRY NEEDS HELP WITH

�●     Determining Network Technical Standards
�●     Capturing RGB 4:4:4 Media 
�●     Problems with Panasonic HMC-151
�●     Working With Canon 5D Mark II
�●     Getting a dSR-1800 to Work 

WRAP-UP 

WELCOME

It may be the dog-days of summer but, gosh, there's a lot going on around here. In fact, I've collected 120 
questions that you've sent in that I haven't had time to publish. So this issue will focus a lot on reader mail. 
Your emails provide me a fascinating look into what's happening today in production. 

Plus, we have a whole new flock of video tutorials, a product review, some brand new seminars, and the 
usual amount of gossip and scandal. 

Providing accurate information is very important to me. I try hard to avoid mistakes and always appreciate 
your comments and corrections to this newsletter, or anything else I create. As hard as I try, I don't know 
everything so I am always grateful for your help.

Also, a new section makes its debut this month -- "Questions Larry Needs Help With." There is so much gear 
out there, it is impossible to keep up. So, I decided to give these questions their own section, so if you know 
the answer, I can easily share it with everyone. 

(By the way, I update each issue for several days after its initial release, so be sure to check back every few 
days to see what others have contributed.)

But, enough chatter, let's get started. 

[ Go to Top. ] 



MAJOR WORKFLOW REVISION: WORKING WITH STILLS

Recently, in working on my upcoming book for Focal Press, I discovered a significant mistake in one of my 
video tutorials (#12 - Working with Stills). I quickly updated the tutorial and sent an email to everyone that 
purchased it giving them a free upgrade to the corrected version. If you didn't get my note - or deleted it by 
mistake - please contact me so I make sure you get the update.

This came about because, as part of writing this book, I took a detailed look at how to prepare still images in 
Photoshop that look great in Final Cut Pro. This is a surprisingly difficult question to answer and, while I got a 
part of it right, I also got a part of it wrong. 

I've written about this before, but now I can explain this better.

As has been discussed many times, computers use square pixels to describe their images, while video uses 
rectangles. So, for instance, while the video frame might have a 4:3 shape, if each pixel inside it is tall and 
thin, you'll have more pixels horizontally inside it than if each pixel were short and fat. Or, said another way, 
if every pixel were big, you'd need fewer of them than if every pixel was tiny.

The overall shape of the frame doesn't change. However, the number of pixels needed to fill that frame 
changes depending upon the size and shape of the pixel.

TWO TYPES OF STILL IMAGES

I'm indebted to Tom Wolsky for some additional insight on this issue. There are two types of still images that 
we can create for use in video: images without transparency and images with transparency.

Images without transparency are, generally, digital photos or scans of photographs. In these images, the 
entire frame is filled with pixels and there are no transparent areas. They are always a single layer, and most 
often saved as a TIFF or PNG. (Tom prefers PNGs, I prefer TIFFs. Both are high quality, uncompressed 
images.)

Images with transparency include single layer logos, where areas around the logo are transparent, as well 
as multi-layer graphical cornucopias of imaging wizardry. These are almost always saved as PSD files.

The reason for this distinction is that Final Cut treats these two groups of images differently. Which means 
we need to size these images differently, in order for them to look correct. If we don't, when we import an 
image, it gets squished, with circles becoming eggs and squares becoming rectangles -- not something you 
want to see happen with a sponsor's logo, for instance.

mailto: larry@larryjordan.biz?Subject=I need the Tutorial Update


This is the classic illustration of what happens when you don't compensate for the differences in pixel shape 
(also called "aspect ratio"). The black circle was drawn in Photoshop and imported into Final Cut. The red 
circle was created in Final Cut. They should match, but they don't. It's caused by those darn pixels acting up.

Note: Chris Meyer has written an excellent blog that goes into lots of detail on how we got 
ourselves into this mess in the first place. If you are curious, as I was, you'll enjoy reading this:

http://provideocoalition.com/index.php/cmg_keyframes/story/par_for_the_course/

NON-TRANSPARENT IMAGES

To design images that behave properly upon import, we need to create them using specific dimensions that 
adjust for these differences. While the math can take another page or two to explain, if you are creating non-
transparent images for import into Final Cut, this table gives you the sizes you need to know.

Video Format Aspect Ratio Image Size Scaled  
Image Size 

DV NTSC 4:3 720 x 540 1800 x 1350 

 16:9 853 x 480 2133 x 1200 

SD NTSC 4:3 720 x 547 1800 x 1368 

 16:9 853 x 486 2133 x 1215 

PAL 4:3 768 x 576 1920 x 1140 

 16:9 1024 x 576 2560 x 1140 

HD 720 16:9 1280 x 720 2560 x 1440 

HD 1080 16:9 1920 x 1080 3840 x 2160 

If you don't want to move around the image, create your image in Photoshop using the pixel dimensions in 
the Image Size column. Because images always look better when they are scaled at 100% oer smaller, if 
you want to move around (the "Ken Burns" effect) inside an image, create it at the size of the Scaled Image 
Size column.

http://provideocoalition.com/index.php/cmg_keyframes/story/par_for_the_course/


Images are always created at 72 dpi, because it is not the DPI that matters, it is the total number of pixels in 
each dimension. And, while this has improved in recent versions, Final Cut does not like images greater than 
4,000 pixels on a size, so I try to make sure my images don't exceed that. 

Recent versions of Photoshop have included the ability to change the pixel aspect ratio (or shape) to match 
the video format of your sequence. The problem is that Adobe and Apple calculate these ratios differently. 
Which means that the Adobe sizes don't work perfectly for Final Cut, though they do work perfectly for 
Premiere Pro. (sigh...)

So, for non-transparent images, if you are in a hurry, the Photoshop presets will get you close. If you want to 
be perfectly accurate, use the numbers in the table.

IMAGES WITH TRANSPARENCY

When we create images with transparency, however, things become more confused. We still have all the 
issues of pixel aspect ratio to worry about, but Final Cut treats these images differently. Non-transparent 
images are imported as graphic files. Transparent images (that is, PSD files) are imported as sequences.

So, graphics files get adjusted for differences in pixel aspect ratio. Sequences do not. And here's where I 
made my mistake. I decided that the best place to correct for this was in Final Cut. While this works, it is 
cumbersome and VERY confusing. A better place to adjust for this is in Photoshop. And that is what I want 
to explain now.

Here's the executive summary: like a non-transparent graphic, you need to create your image in Photoshop 
at specific sizes, depending upon video format. Then, when design is complete, you need to alter its size in 
Photoshop to match the video format you are using. Finally, before importing into Final Cut, you need to be 
sure your Easy Setup matches the video format of your sequence, because FCP adjusts the size of imported 
sequences to match the current settings of Easy Setup.

Complicating matters - as if it weren't already bad enough - the size you alter your image to varies by video 
format, because different video formats use differently shaped pixels. (Remember, all images destined for 
video get created at 72 dpi.) 

Here's the table with the numbers you need. 

Video Format Aspect Ratio Master Image Squished Image 
DV NTSC 4:3 720 x 540 720 x 480 

 16:9 853 x 480 720 x 480 

SD NTSC 4:3 720 x 547 720 x 486 

 16:9 853 x 547 720 x 486 

PAL 4:3 768 x 576 720 x 576

 16:9 1024 x 576 720 x 576

HDV 720 16:9 1280 x 720 1280 x 720 

HDV 1080 16:9 1920 x 1080 1440 x 1080 



DVCPRO HD (P2) 720 16:9 1280 x 720 960 x 720 

DVCPRO HD (P2) 
1080 16:9 1920 x 1080 1280 x 720 

AVC 720 16:9 1280 x 720 1280 x 720 

AVC 1080 16:9 1920 x 1080 1920 x 1080 

RED 1080 16:9 1920 x 1080 1920 x 1080 

XDCAM HD 720 16:9 1280 x 720 1280 x 720 

XDCAM HD 1080 16:9 1920 x 1080 1440 x 1080 

XDCAM EX 720 16:9 1280 x 720 1280 x 720 

XDCAM EX 1080 16:9 1920 x 1080 1920 x 1080 

Video Format. The video format of your Final Cut sequence.

Aspect Ratio. The aspect ratio of your Final Cut sequence.

Master image. The size, in pixels, of your original design. All design work and alterations are 
done at this size. This becomes the master file from which all size adjustments are made. The 
resolution of this image is always 72 dpi.

Squished image. The size, in pixels, of your complete design prepared for import into Final 
Cut. The resolution of this image is also 72 dpi.

THE PROCESS

Create a new image according to the Master size column in the table above. Do all your design work in this 
file. Make it perfect. Get it approved. When your image is complete, you will need to resize it according to the 
Squish column.

To do this, go to Image > Image size.

Turn off constrain proportions - this allows you to set the size of the width and height independently.



According to what I've read on the National Association of Photoshop Professionals website, when changing 
the size of an image, you will most often get the best results by changing the bottom pop-up to Bicubic 
Sharper. This improves image fidelity when reducing the size of an image.

Finally, change the size of either the width or the height to match the settings in the Squished column above 
and click Save.

You now have two versions of the file: the master version, which you'll use if you need to make changes, and 
the file prepared for import into Final Cut.

Next, in Final Cut be SURE the Easy Setups match the video format you are editing. This is a critical step, 
because Final Cut configures your imported sequence to match these settings.

Finally, import your graphic. Because this is a PSD file, Final Cut imports it as a sequence. Double-click the 
sequence to open it into the Timeline, at which point, you can copy and paste elements from one sequence 
to the next. In this screen shot, the circle and the two smaller squares came in perfectly.

it took a long time to get here, but we finally have a reliable way to prepare images for Final Cut that gives us 
accurate imports whether the image contains transparency or not. Having to worry about two versions of the 
same file -- master and squished -- is not ideal. But, the alternative of constantly fighting to get your images 
to look right is far worse.

Whew!

[ Go to Top. ] 

LARRY RELEASES EIGHT NEW VIDEO TUTORIALS  
-- AND A VIDEO COMPRESSION BUNDLE!

I just released eight more video tutorials on Final Cut Studio -- updated another one -- and created a special 
bundle on video compression.

http://www.photoshopuser.com/


My newest tutorials are:

�●     Compressing 16:9 HD for the Web 
�●     Converting HDV to DV in Compressor
�●     Compressing 16:9 DV Using H.264 
�●     Automating Compressor 3 with Droplets
�●     Displaying 16:9 Movies Accurately, with High-Quality, in QuickTime
�●     Using Final Cut Pro's Hidden Selection Tools
�●     Creating Custom Effects in LiveType
�●     Creating LiveType Templates

My updated tutorial is: Preparing Still Images (JPEG, TIFF, PNG, PSD) for Final Cut Pro, which includes 
the new PSD workflow we just discussed. (If you purchased this, a free update is available.) 

My newest bundle is: Video Compression for the Web.

You can find the complete list of my video tutorials here.

You can find the complete list of my video bundles here -- SAVE 30%!

By the way, the most popular tutorials this month are:

�●     Preparing Still Images
�●     Exporting an H.264 Movie from Final Cut 
�●     Retouching Video in Photoshop Extended
�●     Minimizing the Spinning Beach-ball of Death 
�●     Reducing Noise in Audio Clips in Soundtrack Pro
�●     Introduction to 3-D Space in Motion 3

With almost 50 titles to choose from, and priced at only $4.99 each, there's sure to be at least a couple that 
can help you solve the problems you're having. Each title runs 5-10 minutes and can be instantly 
downloaded. 

More titles coming every month! Take a look and order today! 
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REVIEW: DULCE SYSTEMS PRO Q

The folks at Dulce Systems sent me a Pro Q RAID to review. While 
I don't make a living as a hardware reviewer, I wanted to share my 
impressions with you.

First, this thing is FAST! Because it connects via PCIe, rather than 
eSATA, it gets double the speed compared to an eSATA RAID. 
That's even more impressive when you consider that this is a RAID 
5, which provides data protection, as opposed to the eSATA RAID 0, which is optimized for speed with no 
data protection.
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The Pro Q I was sent provided 2.73 TB of protected 
storage and retails for between $2,100 and $2,600 
depending upon interface and storage capacity. Dulce 
Systems RAIDS are sold through dealers; you can get 
a list of them at Dulce's website (www.dulcesystems.
com). You can find more information about the drive 
here: http://www.dulcesystems.com/html/pro_q.html

There are three reasons why you purchase a RAID, as opposed to a single hard drive: 

1. You want greater speed. 
2. You want greater storage. 
3. You want to protect your data in the event of disk failure.

THE STATS

I did my testing on a MacBook Pro laptop using an ExpressCard/34 which is how the RAID connects. 

Note: PCIe is not the same as eSATA. Both use an ExpressCard/34, but the connections and 
speeds are not the same -- more on this in a bit.

As I said at the beginning the Pro Q is fast. In pure speed tests, when totally empty it clocked in at 186 MB / 
sec reads and 164 MB / sec writes. (In comparison, my eSATA system ran at almost half that speed.) After I 
copied 31 GB of data to the system, the numbers were essentially unchanged. This is one quick device.

(While my numbers were not as fast as the numbers reported by Dulce on their website, these are still very 
respectable. Different testing software will also yield different results.)

To get a better sense of file handling, I decided to copy 31 GB of files from a FireWire 800 drive to the RAID. 
The file copy averaged 47 MB / second to copy, with the FireWire drive slowing down the speed.

Then, I decided to copy the same 31 GB of files on the RAID. The file duplication average 64 MB / second, 
probably because the files needed to be sent from the RAID to the computer back to the RAID. I was 
surprised these numbers were this low. 

On the other hand, this performance is fast enough to support every HD video format except HDCAM. I tried 
to time how fast it loaded a project, but it took longer for FCP to get the project organized than to load it from 
the RAID.

Then, I did something I haven't done before. I turned off the 
RAID, pulled one of the drives out to simulate drive failure, and 



powered up the unit. I must confess to a feeling of trepidation 
here, because I need to return this unit when I'm done and I 
was somewhat fearful of the whole thing blowing up. On the 
other hand, the reason you buy a RAID in the first place is to 
make sure you data is safe.

When I powered the system on with the drive missing, it did not appear on my desktop, nor did it give me a 
warning that a disk was missing/inoperaable. However, when I restarted my computer, the system started 
beeping incessantly and would not appear on the desktop. 

When I reinserted the drive, and restarted the system, everything appeared as normal. My lesson here is 
that my data was safe, but I couldn't access it until I got a replacement drive.

IMPRESSIONS AND THOUGHTS

When the drive arrived, it came in two boxes - one with pre-formatted drives and the other with the RAID unit 
itself. Neither box contained instructions so I set this up making my best guess where things went. 

The drives were clearly labeled as to which one was drive 1, 2, 3, or 4. However, the RAID itself did not label 
the drives. While it seems obvious that the drives would be labeled from top to bottom, I've seen enough 
weird numbering in our industry to make me worry. It would not be hard to label the RAID itself to help users 
make sure they are putting the right drive in the right slot.

All drives were on sleds, which meant 
they easily slid into the unit. Assembling 
everything was a matter of minutes.

I REALLY like the long, flexible data cord. No longer am I forced to park the RAID within inches of my 
computer. There was at least nine feet of cord to play with.



I was very confused, initially, by the PCIe connector. While the unit ships with both an ExpressCard/34 card 
for laptops and PCIe card for MacPros (this won't work on G-5s), I originally thought this connected the same 
as an eSATA RAID. This was totally my fault in not understanding the specs, however, it means that I need 
one ExpressCard/34 card for my eSATA devices and a second for PCIe devices. Be sure to not lose either 
one of them.

Another feature I like a lot is that the RAID automatically powers down when the computer goes to sleep or 
shuts down. It also automatically powers up. First, I like this because it saves energy. But I also like it 
because I don't need to remember to turn it on or off.

When I first plugged it in, nothing happened. After contacting tech support, I learned that I needed to instal 
drivers which could be downloaded from the Dulce Systems website (www.dulcesystems.com). After the 
drivers were installed, the system worked flawlessly.

Robert Leong, tech support at Dulce Systems, deserves special mention for the timeliness and accuracy of 
his support. I was very impressed.

While the RAID itself looks pleasant enough, it won't win awards for industrial design. On the other hand, you 
don't buy a RAID for its looks.

The fan is a bit noisy for my taste and until everything warms up it emits a mid-frequency hum that I found 
annoying. Putting the unit on acoustical speaker pads helped some. Moving it farther away from my ears 
helps more. I would not have this unit powered on in the same room that I'm doing audio recording, but this 
is FAR quieter than the old XServe.

I don't have the ability to test the unit for long-term reliability, so I can't provide specific guidance. However, 
the drives are industry-standard, so if a drive dies, you can replace it, and if the RAID enclosure dies, you 
can easily move the drives from one enclosure to another.

All in all, if you are looking for serious speed at a reasonable price with a unit designed for video editing, you 
deserve to take a close look at the Pro Q from Dulce Systems. 

CONVERSATION WITH DULCE SYSTEMS

In learning more about this unit, I sent some questions off to Bill Berry, executive sales manager, and 
Robert Leong, director of technical stuff, both at Dulce Systems.

Larry: Are performance specs different when connected to a MacPro vs. MacBook Pro (I'm using it on a 
MacBook Pro)?

Robert: Yes, [the MacPro will be faster because it supports a faster data transfer across the 
PCIe bus.] The numbers on a Mac Pro (or computer using the PCIe x8 card is 400MB/sec in 
RAID 0 and 300MB/sec in RAID 3).

Larry: Do you have any RAIDs that are FireWire only for laptop users that don't have an ExpressCard/34 
slot?

Robert: Our FireWire devices are the PRO Duo-FireWire, it is a two drive device in a small 
enclosure, RAID 0, 1 only, no RAID 5. Supports FW 800, and USB 2.

Larry: Why should someone buy a Dulce Systems RAID vs. another company that designs RAIDs for video 
production?

Robert: There is no equivalent product that we know of for the PRO Q, being RAID 5 
protection that works on the fast PCIe interfaces (compared to eSATA) on a laptop or a 
desktop. PRO Q has the benefit of high speed data rate (300MB/sec in RAID 5) using on a 
desktop and the flexibility of using it on a laptop.

UPDATE - July 21, 2009



Robin Harris, from Storage Mojo, writes:

In the Dulce review they mentioned that they support RAID 5 on their 4 drive array. I don't 
encourage people to use RAID5 on 4 drive arrays - well, on any SATA arrays - because of the 
risk that you won't get your data back if a drive fails.

My article at http://blogs.zdnet.com/storage/?p=483 explains why in some detail, but here's 
the short version:

SATA drives have a specified Unrecoverable Read Error (URE) rate of about 1 in every 12.5 
TB of capacity. If you have a 4 drive RAID5 with 1 TB drives, and a drive fails, the system will 
have to read all of the remaining 3 drives to reconstruct the data from the lost drive.

During that read of those 3 drives, there is about a 20% chance that the system will encounter 
a URE. When that happens, the RAID controller can't reconstruct the data and the recovery 
stops. Then you have to get out your backup. You have a backup, right?

Note that with larger drives - 1.5 or 2 TB - you have an even greater chance of getting a URE.

What I recommend is one of two strategies with these 4 drive arrays:

�●     Configure the array as RAID 1+0 - which gives you 2 complete copies of your files with 
the performance of 2 striped disks, i.e. roughly double a single disk; or

�●     Configure the array as RAID 0 - which gives you the roughly 4x the performance of a 
single disk, with no redundancy. In this case you should store a copy of your files on a 
cheap set of USB disks, because if a disk fails in a RAID 0 you lose all your files 
instantly.

All the big array vendors now support RAID 6 - which will keep working even after a disk 
failure AND a URE - even though they often use less error-prone (and more costly) enterprise 
drives.

Larry replies: Thanks, Robin, for this insight. 

[ Go to Top. ] 

A NOTE ON RAID LEVELS

RAIDS (Redundant Array of Inexpensive Disks/Drives/Devices) consist of a number of hard drives all 
grouped together so that they appear to the computer as a single device. Because there is more than one 
hard drive in a RAID, they offer greater performance and storage.

There are different levels of RAIDS, identified by numbers:

RAID 0 - Fast, cheap, no data redundancy. Requires a minimum of two hard drives inside the 
RAID enclosure. Most often used when speed combined with low cost are paramount.

RAID 1 - Complete data redundancy. Requires a minimum of two hard drives inside the RAID 
enclosure. Often called "mirroring," each drive is a complete copy of the other. Most often 
used for backing up servers. No faster than the slowest drive in the system.

RAID 3 - Very fast, data redundancy. Requires a minimum of three drives. More popular on 
the PC, should one drive go down, your data is safe.

RAID 5 - Very fast, data redundancy. Requires a minimum of three drives. Most often found 
with four or five drives inside. More popular on the Mac, when one drive goes down, your data 
is safe. This is the most popular mid-priced RAID for video editing and generally connected to 

http://storagemojo.com/
http://blogs.zdnet.com/storage/?p=483


just one computer system.

RAID 6 - Fast, extra data redundancy. Requires a minimum of four drives. This version 
protects your data in the event two hard drives die at the same time. More expensive than 
RAID 5, but, generally, the same physical size. Like the RAID 5 this is most often used 
connected to just one computer. Not as fast as a RAID 5. 

RAID 50 - VERY fast, data redundancy. Generally the domain of very large RAIDs, this format 
combines the speed of RAID 0 with the redundancy of RAID 5 by dividing the RAID into 
sections, where you can lose a drive in each section without losing data. These systems 
generally cost more than $10,000 and contain at least twelve drives. Generally used in 
network and server situations where multiple users need to access the same data.

RAID 60 - VERY fast, extra data redundancy. Generally the domain of very large RAIDs, this 
format combines the speed of RAID 0 with the redundancy of RAID 5 by dividing the RAID 
into sections, where you can lose two drives in each section without losing data. These 
systems generally cost more than $10,000 and contain at least twelve drives. Generally used 
in network and server situations where multiple users need to access the same data.
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THE CASE OF THE TRAPPED DATA

During my review of the Pro Q RAID I discovered a whole new can of issues that I wanted to share with you 
-- along with a request for a solution.

First, let's set the scene. I do almost all my editing on an Intel MacBook Pro system. (While I have nine 
computers in the office, most are iMacs and Mac Minis for staff and servers, with a trusty G-5 that I use for 
almost all my writing. The laptop is my only Intel/Mac system.)

I'm a big believer that storage needs to be big and fast and, ideally, safe. However, both "big" and "fast" are 
terms that rapidly change in the hard disk industry. Currently, I have an eSATA hard drive from LaCie (2 
years old), an eSATA S2VR RAID from CalDigit (1 year old) and, now, this new Dulce System RAID that I'm 
testing.

On the CalDigit system I've got about a terabyte of data that I wanted move to the Dulce system and use that 
data to test how the Dulce works.

Easy to say. Impossible to do.

First, the Dulce Systems RAID uses a connection protocol called PCIe. While much faster than eSATA, it 
uses an entirely different connector and ExpressCard/34 to attach to my laptop. Neither the CalDigit nor the 
LaCie support PCIe. There is only one ExpressCard/34 slot on my MacBook Pro -- and NONE on the current 
versions of MacBook Pro, which is ridiculous and I wrote about this last month -- so I can't connect both the 
Dulce and CalDigit systems.

My data is trapped. I want to move it to a bigger, faster drive, but I can't.

First, while I could buy an external 1 TB FireWire drive and connect it via FireWire to transfer the data from 
drive 1 to drive 2, this is not an easy solution if I have several terabytes of video files to transfer.

Second, I discovered that not all eSATA connectors are the same - systems from two different 
manufacturers use two different eSATA connectors. Both incompatible.

Third, eSATA can't be daisy-chained. So looping from one drive to another is not possible.

Fourth, if I have an Intel MacPro, which I don't, I could add multiple cards that allow me to connect the 
eSATA devices using a multi-port eSATA card and the PCIe device, using an 8x PCIe card and transfer data 



between them.

But I don't own a MacPro - yet - so I'm back to being stuck.

MORE OPTIONS 

I shared my frustrations about the difficulties of moving data between systems with Robert Yeong, director 
of technical stuff at Dulce Systems. He replied:

If [the other drives] are really eSATA then they should all be able to connect to an eSATA 
adapter. Sometimes connections are called eSATA but they really are not. eSATA [devices] 
by design are not daisy chain-able (loop), they are point-to-point connection.

Our PRO Duo-eSATA and HD Commanders are eSATA, that is to say it has an eSATA 
connector on the back which then connects to a eSATA port on the adapter connected to the 
computer.

The PRO Q is not eSATA, it is extended PCIe with x1 connection and x8 connection.

So let's see how we can un-trap your data on a eSATA device and move it to another eSATA 
device. You will 1st need to have an adapter with enough eSATA ports to support the 'source' 
device then additional ports to support the 'destination' device. Depending on the exact 
equipment, a typical two ported eSATA ExpressCard/34 adapter might or might not have 
enough ports to do the task. 

For example, Example 1: our PRO Duo-eSATA is a two drive unit and have two eSATA ports, 
one port for each drive inside the enclosure, typically both are used so the two drives can be 
striped. So if this was on a Mac Book Pro with a two ported eSATA ExpressCard, then you 
can not hook more eSATA devices to the Mac Book, so your data is trapped as far as getting 
it off to another eSATA device.

Example 2: Our HD Commander is a five drive unit and have only one eSATA port, it uses an 
internal Port Multiplier to gang five to one, it's a pretty simple setup and does not provide 
internal RAID features, so all the five drives are see as five different devices to the computer 
(striping is done by the OS). Anyway, since the HD Commander uses only one eSATA port, 
that 
will leave the other eSATA port on the Express Card available, so another HD Commander 
can be connected to it and used as the 'destination' device. 

In a Mac Pro setup, there is a 4 ported eSATA PCIe card which give us more options to 
arrange the 'source' and 'destination' devices to transfer the data.

Larry adds: Thanks, Robert.

While these options allow us to move data from one eSATA drive to another, neither of these options allow 
us to move from an eSATA drive to a PCIe drive unless we use a MacPro with two cards: eSATA and PCIe. 
This is fine if you own a MacPro, but a serious limitation if you don't.

So here's a challenge to the hard drive community -- as you start to make bigger and faster RAIDS and hard 
disks, you need to help us figure out how to move data from one incompatible connection format to the next. 
We can't count on Apple to support us. Apple seems to be dropping ports on laptops as fast as possible.

As our need for storage continues to escalate, and new connection technology appears, all of us with legacy 
data are increasingly faced with stranded data which can only slow down the adoption of new technology.

Whether this is a data transfer service, low-cost interconnections, or high-cost interconnections which can be 
rented and returned when done, this issue of trapped data needs to be addressed.

UPDATE - July 20, 2009



Ben Balser adds: 

Don't forget the MacBook Pro 17" does have an ExpressCard/34 slot. Also, on this issue of 
transferring data, if you have access to another Mac, an Ad Hoc Airport connection would 
work just fine, and is super simple to do. Could have been a mention in there about that, eh?

UPDATE - July 21, 2009

Paul Stratford, adds:

Rather than a slow Ad Hoc airport connection, there’s always Firewire/target mode (only 
applicable if the system drives are big enough) or ye olde gigabit Ethernet or IP over Firewire.

Larry replies: These are all good points. Thanks for reminding me. 

[ Go to Top. ] 

SPEND A DAY LEARNING WITH LARRY

One of the most frequent requests I get is to 
present a Final Cut seminar that covers material 
not part of the traditional Apple training classes 
and at a reasonable cost.

RIGHT NOW is the best time to improve your 
skills -- the economy is slow and clients are scare Its time to prepare for the future. When we are busy 
working there’s no time left to study.

HIGH-QUALITY, INEXPENSIVE WORKSHOPS -- ONLY $79! 

We set ourselves the following goals:

�●     Create high-quality seminars filled with hard-to-find information
�●     Make the seminar less expensive
�●     Take the seminar out of downtown LA
�●     Add more time for questions and discussion

So, I’m delighted to announce two brand-new seminars:

�●     July 28 - Santa Ana, CA. Sponsored by Video Resources Inc. 
�●     August 4 - Folsom, CA. Sponsored by Silverado Systems, Inc. 

Click here to see the full agenda. Even better, each full-day seminar is ONLY $79! 

We have about 5 seats left in Santa Ana - so please register soon to reserve your seat.

I've reserved almost two hours at each seminar to make sure you get your hardest questions answered. I'd 
love to see you there! 

Please register today! 

[ Go to Top. ] 

http://www.larryjordan.biz/seminars
http://www.videoresources.com/
http://silverado.cc/shop/home.php
http://www.larryjordan.biz/sem/2009_socal.html
http://www.larryjordan.biz/seminars


LARRY IS BRINGING HIS SEMINARS TO THE UK IN AUGUST! 

Our Febraury trip to the UK was a great 
success - so we are coming back!

Hosted by Academy Class, we will be 
visiting four cities and conducting five 
seminars:

�●     Aug. 18 - Edinburgh
�●     Aug. 19 - Manchester
�●     Aug. 20 - Bristol
�●     Aug. 21 - London
�●     Aug. 22 - London

The second London seminar is an 
advanced Master Class.

I really enjoyed meeting with folks 
during our last tour. There is so much interesting work being done outside the US, there was lots of of great 
questions and plenty of fascinating discussion.

This will be our last trip to the UK this year, so I encourage you to register soon before seats fill up.

Click here to learn more. 

[ Go to Top. ] 

FIXING OUT-OF-SYNC AUDIO

Audio that slowly drifts out of sync is due to a mismatch between the sample rate at which you shot the video 
and the sample rate at which you captured the audio. Here's an article that describes this in more detail.

However, Matt wrote in with the following problem:

Someone shot some footage (9 minutes) and gave me an MOV that plays fine in QuickTime 
but when I put it in Final Cut the audio is out of sync. [It gets] progressively worse as the 
minutes pass. The files are 44.1 khz, I put them in a 48 kHz sequence and they are out of 
sync, even after rendering. I've tried converting them to 48 with STP , and putting back in 
timeline, didn't work.

I can get them to sync in the Final Cut Timeline by changing the speed  
of the audio to about 99.6, it would look pretty good playing from timeline. But when I export to 
a QT MOV they are out of sync again.

I tried deleting Final Cut preferences and that didn't work. But here's what did:

�●     took the MOV with 44.1 Khz audio, put it in Quicktime, where it had always played fine,
�●     exported to 48 khz MOV. 
�●     Put it back in final cut - still out of sync
�●     Imported the 48 khz from QT to Imovie - output to QT MOV 
�●     Took that MOV and imported into FCP 
�●     It was sync'd in final cut. 
�●     Output to Quicktime movie and it was sync. 

Maybe somebody has a better solution, this Rube Goldberg method is tedious but it worked. 

http://www.powerupevents.co.uk/
http://www.powerupevents.co.uk/
http://www.powerupevents.co.uk/
http://www.larryjordan.biz/articles/lj_32_kHz_audio.html


UPDATE - July 21, 2009

Tom Mountford, from Norfolk, UK, adds:

I read Matt's sync problem and the Rube Goldberg solution and may be able to improve on it. I 
have had a similar problem with sync issues when using the ProRes HQ codec - audio 
imported from my sound suite drifts out of sync as the minutes pass despite the sample rates 
being 48KHz throughout the process - I've found other references to it online and it seems to 
be a bug in way the ProRes codec locks audio to video. Anyway, that aside the solution I 
found was to drop the QuickTime movie into Compressor and pull a 48KHz 16-bit AIFF from it 
and substitute that for the original track using FCP and create a new .mov from the corrected 
sequence.

Larry replies: Thanks, Matt and Tom! 

[ Go to Top. ] 

MAKE RENDERING GO FASTER

Eric Jabouille writes:

We spend a lot of time RENDERING files in FCP. HOW is it possible to make that process go 
faster?

Larry replies: Great question.

There are four things that determine rendering speed:

1. The speed of your processors 
2. The video format of your media 
3. The complexity of your effects 
4. The amount of RAM on your system

Of these four, the speed of your processors makes the most difference. Until Snow Leopard and a new 
version of Final Cut ships, Final Cut does not take significant advantage of multiple processors. It should, but 
it doesn't. 

Instead, if you want to render faster, buy a computer with a faster clock speed. Also, Intel chips will render 
faster than G-5 chips.

Next, SD images have fewer pixels than HD, which means the SD renders many times faster than HD. In 
general, I've found that HD takes about six times longer to render than SD. HDV, in fact, is a very difficult 
format to render quickly. My tests have shown that changing your render settings to ProRes will increase 
HDV render speeds up to 40%. 



You set render settings for the current sequence in Sequence > Settings > Render tab. This only works for 
HDV and XDCAM footage. 

Also, the more filters you apply to an effect, the longer it will take to render. In fact, when you look at a list of 
filters, those that are in bold type generally display in real-time without needing to render prior to output. 
Effects that are not bolded won't play in real-time and will also take longer to render.

Also, up to a point, adding more memory can improve render speed. Currently, Final Cut does not use more 
than 4 GB of RAM in your system. However, if you only have 1 GB of RAM, adding a bit more can help. 
However, you won't see any improvement in render speed if you suddenly cram 16 GB of RAM into your 
system.

UPDATE - July 20, 2009

Ryan Mast adds: 

Eric, your system's GPU (video card) can also factor into render times. FxPlug plugins will 
sometimes render in the GPU instead of the processor. According to Apple's FxPlug SDK, 
Final Cut Pro 5 will generally ask the plugins to render in the GPU, and Final Cut Pro 6 will 
generally ask the plugins to render in software, unless the plugin is set to render only in the 



GPU. So, if your render seems slow and the CPU bars in Activity Monitor aren't pegged close 
to 95%, it's possible that the bottleneck in your system is the GPU, or your hard drive's speed.

Larry replies: Thanks, Ryan. 

[ Go to Top. ] 

WE ARE WORLDWIDE!

OK, this really belongs in Reader Mail, but while I get letters from all around the world, I don't get many from 
Antarctica -- in fact, this is the first. 

Dr. Marcelo Mammana, from Jubany Station - Antarctica writes:

You are the expert here, but after a quick browsing at apple.com store, I just find that the 
current MacPros are the only Macs with more than one FW ports, the others (both laptops and 
iMacs) have only one (at least, this is what the specs say). I currently have a MacBook and a 
MacMini (also an old PowerMac 7200 that is sleeping in my garage).

Anyway, I didn't know that I could connect my camera to the second port at my external hard 
drive. I mean, yes, I noticed the second port and yes, I could figure out that this could be 
possible, but thought that it was not convenient, so this is a very useful tip!



Here are an aerial image of the Jubany Station, and an underwater image (I am also an 
underwater photographer), got at San Martín Station, in 2007 where I also wintered over.

Larry adds: As I write this newsletter, it is close to 100 degrees outside - it seems even hotter in her where 
I'm writing. Your underwater shot of the iceberg is refreshingly amazing!

[ Go to Top. ] 

ANOTHER POINT OF VOICE ON A FILE ORGANIZATION SYSTEM

Tom Mountford, senior editor for the JMS Group Ltd n Norfolk, UK, writes:

I was reading Anna B's question on 'Where to store files' and thought I would share my filing 
system. Being extremely paranoid about keeping my data both organized and safe I've always 
operated the procedure of a single directory for each job - even though some may consider 
that placing all my eggs in one basket it is a basket I can mirror each evening to an external 
drive, or copy to my thumb drive to take home with me - all using a single drag and drop.

To begin with I create a folder on my RAID with the client and job name. I then create an FCP 
project, save it in the folder I just created, then I switch the scratch discs to also reference this 
folder (the only snag, but one I have got used to, is making sure I remember to change the 
scratch disc preferences each time I move between projects). Now that I have a client/job 
directory containing an FCP project, and the automatically created Capture Scratch and 
Render Files/Audio Render Files directories I go on to add a few extra folders of my own. 
These are: 'AE' for After Effects work relating to the edit - within this folder I have sub-
directories named 'Sources' (very handy place for housing client-supplied artwork and logos 
etc) 'Workspaces' and 'Renders'. I create a folder named 'DVD' in which I can place the .m2v 
files and DVD Studio projects for the inevitable final client copies of the job. Lastly I create an 
'Imported Audio' folder - where I can place the music tracks, voiceover and final mix which 
have been produced elsewhere and sent to me as files. I am now working for the most part 
tapeless so don't capture anything directly into the capture scratch directory - but I manually 
place my XDCAM footage into this folder, with the added benefit of being able to split it up into 
scenes/shoot days using the Finder/Quicklook - and then just use 'Import Folder' in FCP to 
import the pre-arranged footage bins.



  
  
  
  
  
  
  
  
  
  

I use an identical file system for every job - so I can go back to work I was doing three or four 
years ago and not have to refresh my mind where anything is. It makes archiving easier too - 
knowing 100% that everything relating to a project is in the one directory eliminates the 
possibility of 'could not locate media' warnings later on. 

Hope that's of help to a few people!

Larry replies: Thanks, Tom, for writing this up. Organization is SO critical to successful editing, I'm happy to 
share your system.

I have a real problem recommending changing scratch disks because if you forget even once, FCP starts 
storing files in places you don't expect. FCP is just not designed to move scratch disks between projects. I'm 
hoping this gets fixed in a future version of FCP.

That being said, I agree with the rest of your ideas where you store all project files in a single folder, using 
subfolders to keep things organized. 

[ Go to Top. ] 

TECHNICAL UPDATE: WHAT IS BIT-DEPTH AND QUANTIZATION?

Bob Sloan writes:

i have two camcorders, one has 12 bit camera quantization, the other has 10 bit camera 
quantization. They both have 8 bit video quantization. (I'm referring to Panasonic DVCPRO-
HD Varicams & HDX900's)

What is the technical difference? 
What is the technical difference in picture quality? 
What is the perceived difference in picture quality?

Larry replies: For me, the higher the bit depth, the more accurately the digital image can represent the actual 
image.

But, this is a GREAT question to send to Philip Hodgetts and he graciously sent me the following response:

I'll certainly pretend to have an answer :)

My understanding is that we're talking, essentially, the same argument that I've propounded 
for a while that "oversampling at source is good throughout the process". Now usually that 
refers to pixel-based resolution, and is the reason that any HD camera (from Flip mini to HDV 
to Viper) will create awesome SD content, because the source is oversampled relative to the 
result. Likewise a RED One will produce nice HD because the source is oversampled.

I think that's what's going on here: there is a final conversion to 8 bit that happens at the 
codec/encoding stage. If the source information is compromised (10 bit vs 12 bit quantization) 
then the quality of the signal going into the encoder is lower. In this case gradients and 
smooth level transitions will be marginally more compromised with 10 bit source than with 12 
bit source. Any encoder can only work with what it's given, so giving it a higher quality source 
will let the encoder work provide a better result (all else being equal).

However, let's be real about this. About the only way you're ever going to see the difference is 
in side-by-side difference-mode testing. The 8 bit compromise on the final encode will have 
way more affect on the result than the difference between 10 and 12 bit quantization. But in 
theory 12 bit would be better because it's "less compromised" than the 10 bit source.

But seriously, we're talking the difference between 256 levels-per channel in 8 bit, to 1024 



levels per channel in 10 bit to 4096 levels per channel in 10 bit. 8 bit definitely leads to 
banding on smooth gradients, but I've never seen it in 10 bit and I think the difference will be 
indistinguishable.

But it sure looks good in marketing! :)

Larry adds: Thanks, Philip and Bob.

[ Go to Top. ] 

PASSING THOUGHTS

This is a collection of quick notices and thoughts from readers that don't require any special comment from 
me. 

EVEN TOYS ARE USEFUL

I don't know whether to be excited or depressed. Probably both. Gary Kuiper sent me this:

I listen to [Digital Production BuZZ] every week. Pretty sweet. You guys are responsible for 
tipping me off to the NAB. I've only been floating around this industry for a couple years 
merging from a commercial photography background. Anyway, I thought you guys might get a 
kick out of this video I shot and cut (Final Cut) and posted in AE. It was entirely shot on 2 
GoPro water cameras. Low lighting made the footage a little ghetto but kind of added to the 
rockabilly charm.

Here's the link: www.youtube.com/watch?v=Dj-4AhkuGas

In proper lighting, these cameras do well. We use [them] for shooting surf and skate videos.

Larry adds: First, this shows that a good idea does not require expensive gear. Second, black and white 
hides a lot of color problems.

[ Go to Top. ] 

PICKING A RAID

Dennis Rosenblatt sent me this:

Like many, i've been deliberating over a replacement for my xserve raid for quite some time 
now. i didn't want to buy the promise raid and was having trouble finding a 4 GB 16 bay, mac 
friendly box. at nab last week, i found what i was looking for and wanted to pass it along. it's 
the Active xRAID from Active Storage, Inc.

The guys at active storage are refuges from the xserve raid project at apple. it's a 4 GB fiber 
box with dual controllers and 16 enterprise class hitachi drives for $15k. it will be upgradeable 
to 8 GB fiber sometime down the road requiring the replacement of two raid controller 
daughter cards.

the specs are impressive but their credentials and commitment to the mac community is 
equally impressive.

i thought i'd send you a link to their site in case you wish to check it out. 

http://www.digitalproductionbuzz.com/
http://www.youtube.com/watch?v=Dj-4AhkuGas
http://getactivestorage.com/products.php
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SCROLLS AND CRAWLS CAN'T EXCEED TWO MINUTES

Ben and Catherine both sent me separate emails about this:

In a recent newsletter, you mentioned about how to create a text clip in FCP longer than 2 
minutes. You didn't mention that crawls will only show 2 minutes worth of text, no matter how 
long you make them in the Viewer.

UPDATE - July 20, 2009

Andy Mees adds:

Your readers Ben Balser and Catherine both sent you emails suggesting that crawls will only 
show 2 minutes of text no matter how long you make them in the Viewer ... in fact the limit is 
not quite so easily defined as that might suggest.

As it turns out, the limit is actually based on a much geekier issue, that being a maximum 32K 
limitation imposed on a text string's display length (in pixels) as calculated by an internal 
function call of the Crawl plug-in. (This is due to the nature of the underlying Carbon functions 
exposed by the FxScript language that is used to describe these plug-ins in FCP.)

It doesn't matter if your Crawl is 2 seconds or 2 hours, the text will be truncated at the point at 
which its calculated display length exceeds 32000 pixels. For what its worth, I found this out 
when writing my Fixed Crawl text plug-in, where I faced the same basic issue :-(.

Larry replies: Well, Andy, that certainly clears THIS up! Sheesh.... 

[ Go to Top. ] 

TIMECODE CALCULATOR

Steve Sebban writes:

I released a few months ago iTC Calc, a timecode utility aimed to the professional market and 
FCP editors for iPhone and iPod Touch. If you are interested to write a review about it, I will 
be happy to provide to you a promo code for a free copy.

You can get more information about iTC Calc at my website: http://www.itccalc.com.

[ Go to Top. ] 

AMAZING UNDERWATER FOOTAGE

Jody Eldred sent this in:

Here's some incredible slo-mo surfing footage taken from in/under the water-- supposedly the 
first of its kind. (Wish I'd shot it!)

Be sure to click the "HD" button to see it in fuller res. Amazing.

http://www.itccalc.com./


http://gizmodo.com/5244114/100000-camera-captures-slow-mo-surfing-from-underwater?
autoplay=true
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DECONSTRUCTING FLASH MOVIES

Nicolas Nilsen writes:

I downloaded an .FLV file and I wanted to extract the sound into a separate file. I also want to 
convert it into a QuickTime movie.

Just wanted to let you know I can do all of this with Perian - http://perian.org/

This is a very cool QuickTime utility.

UPDATE - July 21, 2009

Paul Stratford, adds:

Using Perian can mean some other movies open in monochrome with green bars in QT player 
et al. Try moving the perian.component file from \Library\Quicktime. This can be done on-the-
fly provided you quit from anything that’s using QT at the time. You could just leave the 
component file hanging around on your desktop (or somewhere) and copy it back when you 
need it.

Larry replies: Thanks, Paul! In other words, remove the component when you don't need Perian and add the 
component back to that location when you do. 

[ Go to Top. ] 

READER MAIL

PREPARING RAW IMAGES IN PHOTOSHOP ELEMENTS

Kent sent this in:

Larry, recently, I purchased Photoshop Elements to prepare some RAW images for import into 
Final Cut. I thought some of your readers might be interested in my workflow. As part of this, I 
needed to be sure my images were large enough to do the Ken Burns effect.

1.  Locate picture in Bridge, double click which loads it into the Raw Window
2.  In the Raw edit window adjust exposure etc. click open image
3.  Picture than opens in PS Elements. 
4.  Click crop tool. Set Mode= Fixed Aspect Ratio Width =1920 or 3840 Height = 1080 or 

2160, Resolution = 72
5.  Crop picture across picture. Click green arrow
6.  Picture reopens in PSE
7.  Image/Resize/Image size set dimensions as in 4 above with Resample Image checked 

and Bicubic Sharper for down size, Bicubic Smoother for up size
8.  Click OK
9.  File/Save As/Name = ?, Where = FCP documents folder for that project 

Format = Tiff or PNG/Ok
10.  Tiff Option window, Image Comp=None, Pixel order =interlaced, Byte order= 

http://gizmodo.com/5244114/100000-camera-captures-slow-mo-surfing-from-underwater?autoplay=true
http://gizmodo.com/5244114/100000-camera-captures-slow-mo-surfing-from-underwater?autoplay=true
http://perian.org/


Macintosh, click OK
11.  Open FCP and import WALLA!!!!!!!

[ Go to Top. ] 

ISSUES WITH AUDIO SYNC IN QUICKTIME

While I have not run into this problem, Philip Fass sent me the following:

Not sure if you've covered this in the newsletter before, but I've just discovered (the hard way) 
a major bug in QT. As I look around the web, it seems it's a fairly well known issue.

In a QT movie exported from FCP, if the movie is longer than about 30 minute, the audio and 
video go out of sync. The audio runs ahead of the video by maybe 3 seconds in a 2 hour 
video. Eventually it looks like a very badly dubbed foreign film.

Philip then sent me a second email with a solution:

Larry, I just wanted to report an effective solution to the QT sync issue: Export QT files of 30 
min or less, batch process them in Compressor, and assemble them on a DVDSP track. It's 
after about 30 minutes that QT "lets go" of sync.

This could be a big relief to some of your readers!

UPDATE - July 20, 2009

Ben Balser adds: 

Philip Fass has a common problem I hear about with .mov files playing out of sync in QT 
player. I've had two consulting clients encounter this problem recently, and both are using 
Long GOP based codecs (HDV). When we export as Pro Res or DVCPRO-HD, the problem 
goes away. I'm wondering if it's a Long GOP playback issue with the computer hardware 
simply not keeping up, rather than anything embedded in the video file itself. I'd like to see 
Philip take one of these out of sync clips into DVDSP, burn it to a DVD, and play it back on a 
set top DVD player. Would it still be out of sync?

Larry replies: Oops, I forgot. Thanks for reminding me. 

[ Go to Top. ] 

MAKING AN AUDIO INSERT EDIT

Nicolas Nilsen writes:

Just a question concerning SOUND TRACK: I have a piece of music and I'd like to 
DUPLICATE a bit AND INSERT it at a very specific place. In FCP words, I'd like to make an 
insert edit (not an overwrite).

Here's what I did : (1) copy the bit (2) put the playhead at the right place (3) menu Edition -> 
special paste -> paste by insertion (but it's grayed out ! I can't "INSERT" it!

What am I missing? :-)



Larry replies: This is a great question, thanks for writing.

In Soundtrack Pro, when you are in an Audio Project, illustrated in your screen shot, selecting Edit > Paste 
does an insert edit automatically, provided you don't have any audio selected. If, on the other hand, you 
select a range of audio, Pasting will replace the selected portion with the inserted portion.

In a Multitrack track project, its a bit trickier. Edit > Paste > Insert will be grayed out unless you use the 
Timeslice tool to select a PORTION of an audio clip and copy it to the clipboard. Selecting an entire clip 
disables Paste Insert. To select a portion of a clip, drag the Timeslice tool across the audio you want to 
select.

Then, be sure the track containing the clip you want to insert into is selected and the playhead is positioned 
where you want the audio to be inserted. At which point, Paste > Insert will work.

[ Go to Top. ] 

STUTTERY AUDIO PLAYBACK

Willard Jansen writes with both a problem and solution:

I am currently watching your Soundtrack Pro 2 video's on Lynda.com. Great stuff. I have never 
done audio before because everything I do goes to a specialized protools editing shop for 



voice overs and mixing. But I nevertheless wanted to dive into soundtrack because a have it 
and thought it might become handy sometime.

I am using your exercise assets as well as my own projects to practice. BUt something seems 
to be wrong. On all projects, even single clips with only two tracks of audio, playback stutters 
and stops as soon as 1 or 2 seconds after playback starts. Here in my home studio am on an 
G5 quad core with two Western Digital 1 TB MyBook firewire 800 drives that hold the projects 
and media. I tried the second drive in the computer, same result.

I searched blogs and discussions and found that more people have suffered from this. There's 
even a lot of bad sentiment about soundtrack. But since on your video everything seems to be 
going so well and editing in FCP is going very well in my setup here, I figure that there must 
be some secret setting that I am overlooking although a copied the setup of preferences from 
your video's.

Larry replies: Willard, I edit for hours each day in Soundtrack and have never seen this problem. It must be 
something to do with your system. Be sure to trash your STP preference file:

[ Home directory ] > Library > Preferences > com.apple.soundtrackpro.plist

Willard writes back:

Here's what I did after the procedure you described.

�●     Clean install OSX + FC studio + updated everything: problem remained
�●     Set audio output to internal: problem remained
�●     De-installed Blackmagic Intensity drivers & software: problem remained
�●     Took out the Blackmagic Intensity card (2nd PCI slot from top: problem solved
�●     Put back intensity card in topmost PCI slot: still no problem
�●     installed intensity software: still no problem
�●     problem solved

Larry adds: Thanks for letting me know. For some reason, all slots in MacPros are not the same. Be sure to 
check with the supplier of any cards you have to be sure they are installed in the right slots.
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OUTPUTTING MONO AUDIO

Eric Jabouille writes:



I have a sound effect (Drone dark suspense) that's in the sound library of STP. It has 6 
channels and (let's say) I'd like to export it as a MONO track. I've saved the file, went to "File" -
> "Export" ..... and the "export" function it's grayed out!

How am I supposed to FLATTEN a 5.1 file into a mono file? If I use the "save as" option, I can 
export it as an AIFF file but it keeps the 6 channels. I want to flatten it first. Is it possible?

Larry replies: Eric, you are doing the right thing in the wrong place.

Audio file projects don't allow you to flatten all tracks into mono - but a multi-track project does.

Load your six-track audio file into a multitrack project. While you can easily convert this to mono by changing 
the setting of Submix 01 at the bottom, the problem with this approach is that it only gives you audio from 
one track - front left (mono 1) or front right (mono 2).

A better approach is to switch Submix 01 to Stereo 1-2. This outputs both front channels, which contain all 
the important elements of your sound, then use Final Cut to create the final mono mix for your project.
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WHAT'S GOING ON HERE?

Mark Labbato writes:

Whenever I send an audio file to SoundTrack Pro, not a multitrack project, but an audio file 
alone. In soundtrack Pro the file contains not the file I sent from the timeline in FCP, but the 
whole entire clip of the audio that the clip in the timeline is associated with in FCP. I'm not sure 
what I'm doing incorrectly. I'm highlighting the clip in FCP, and from the pulldown menu, 
sending to soundtrack pro audio project, and the entire segment is sent, not the edited clip. 
Could you lend me your expertise on this question?



Larry replies: You are not doing anything wrong. FCP is designed to send the entire file to Soundtrack Pro 
for processing. 

However, with the release of Soundtrack Pro 2, Apple added a neat feature - two markers that indicate the In 
and the Out of the clip in Final Cut. To select just that specific region for processing, double-click anywhere 
on the audio waveform between the two markers. That selects just the area you are using in FCP, which 
decreases the amount of time you need to work with audio you won't be using.

Also, remember that STP makes a copy of your source file, so even if you make changes to audio outside 
the In and the Out, this won't be reflected back to other clips in the Timeline. This prevents you from 
accidentally damaging audio you are using elsewhere in your project.

UPDATE - July 20, 2009

Dave Bergan adds: 

In reference to the reader mail in the latest newsletter “What’s Going on Here?”, I think its’ 
worth noting that you do not have to send the whole audio file to STP from FC. When you 
send the file from FC, if you chose “Send only referenced media”, the file created is based on 
the sequence clip so the whole file does not have to be copied. This is especially useful if you 
have a very long take, like an interview, and want to send only a short clip to STP.

Larry replies: Thanks, Dave. 
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GETTING FROM HERE TO THERE THE HARD WAY

Dominique writes (and I'm summarizing here):

I'm shooting Sony EX1 video at 25 fps. Rather than shooting XDCAM, we shot using the HDV 
1080i/50 codec in the camera. Our editor converted all the footage to ProRes 422 and finished 
the edit. Now I want to convert it to output to HDV tape so that I can take it to a post-house to 
convert to DigiBeta.



Also, where do we set the reference tone when we output to HDV tape? I couldn't find 
answers to any of this anywhere.

Larry replies: HOLY SMOKES! 

I'm not surprised you couldn't find answers - this is a bit, um, convoluted! You are not making it easy on 
yourself. 

The first big problem is that you are converting this poor video into way too many different formats. Its like 
over-bleaching hair. At some point, you've processed it too much and the hair just gives up and falls apart. 

Let's start with the "what you should have done," then we'll move on into the "what you can do now."

Since you were shooting an EX1, I would recommend shooting at the highest quality that format supports 
XDCAM EX 35 mbps. This is a much better format than HDV. Yes, file sizes are bigger. But you would avoid 
the quality hit you take by moving into HDV.

Your editor was correct to convert it into ProRes. This is an excellent codec for editing while maintaining the 
best possible quality.

However, now that you have your sequence edited as ProRes, my recommendation is to use File > Export 
> QuickTime movie and create a QuickTime movie containing your ProRes video. (Be sure to check "Make 
Movie Self-Contained.") 

Your six-minute movie will be about 6.5 GB in size - not too big as video files go.

Then, copy that ProRes file to a hard drive and send the hard drive to the post house. They will load that into 
their system and convert to for output to DigiBeta. Most post houses can do this conversion. If the one you 
selected can't, find one that can.

While we can copy digital files without damaging quality, converting between formats - especially HDV - can 
do significant damage. In this case, your video went through four different conversions. 

�●     Source HDV > ProRes
�●     ProRes > HDV (for output to tape)
�●     HDV > ProRes or DNxHD or DVCPROHD (on ingest at the post house)
�●     ProRes > DigiBeta (final output)

Anything you do to reduce format conversions will improve final quality.
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EXPORTING HDV FOR DVD STUDIO PRO

Nando writes:

i just shoot a video of 24 minutes in my JVC GY-HD 110U and i have my footage ready to 
export to DVD SP but i can find the best quality to export... Please Can you Help me? I really 
need this job at end of this weekend and i can’t find a good quality of video to export....!

Larry replies: Nando, the JVC shoots HDV, which is a version of high-def. DVD Studio Pro needs standard-
def video. So, you need to downconvert your HDV video into something DVD Studio Pro can read -- it can't 
deal with HDV at all.

A good way to do this is using Compressor - where you piock your compression setting to be the final output 
that you need; in this case MPEG=2. There are several presets in Compressor that will work. Just keep in 
mind this needs to be done in Compressor, not DVD Studio Pro.



Here's a video tutorial that I created that describes a portion of this process.

www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=139

[ Go to Top. ] 

DVD SUBTITLE QUESTION

Matt Ferguson writes:

I ran across some of your posts on DVD Studio Pro and I thought you might be able to help 
me with an issue I am having. 

I am creating a DVD with two subtitles. I am trying to make the DVD as similar in authoring as 
a previously released DVD that was created in Scenarist. 

The issue I am having is that when the end user presses the subtitle button while playing a 
track on the previously released DVD it cycles through the two subtitle streams, then shows 
an "off" selection. In DVDSP the only way I have found to create an "off" state is to create a 
"dummy" subtitle track (stream 3). This is not going to work in this project.

Is there any way to emulate the previous DVD and have a subtitle OFF state without creating 
a new subtitle track? Thanks for any input you have.

Larry replies: You can easily do this, but it takes a script. Subtitles have two states: one which determines 
which subtitle track to use and a second to turn the display on or off.

You can toggle this manually by selecting the name of your DVD in the Outline menu of DVD STudio Pro, 
then turn View on or off. View determines when subtitles are displayed. This checkbox also exists in the 
Simulator. The pop-up menu next to it determines which subtitle track is displayed. 

However, it is much easier to do this with a script and tie it to a menu to toggle subtitles on or off. What I do 
is create a button to select a subtitle language, then another button to turn subtitles on or off.

To do this, you need to determine the value of SPRM 2. For instance, if subtitle track 1 is selected this has a 
value of 0, if the track is both selected and visible, SPRM 2 has a value of 64. You can query and change the 
value of this variable using a simple 4 line script. The DVD Studio Pro manual describes how to do this in the 
chapter on scripting. 

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=139
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IMPORTING TEXT INTO FINAL CUT PRO

Andy writes:

I enjoy working with the text features in FCP slightly more that than going to the dentist, but 
only slightly less than extracting my own teeth. Whenever I create text somewhere else 
(InDesign, Word, TextEdit, whatever) and then copy it and paste it into FCP, it automatically 
brings it in in one really, really long single line. It doesn’t seem to matter how I format it or 
break the lines or add spaces, it just dumps it into the world’s longest run-on sentence. Is 
there a trick I don’t know? Or am I forever doomed to reformatting endless lists of names and 
titles in one of the most user un-friendly features of an otherwise fantastic program. Thank you 
in advance for your wise, all-knowing answer, and for being gentle if the answer is “you’re 
screwed.”

Larry replies: Hmmm... this works fine for me.

I just created a new Text Edit document. Added some names, with a return after each line. Copied it to the 
clipboard. Pasted it into a new Full Text clip in the Viewer of FCP. All carriage returns were displayed 
properly.

However, Andy couldn't get this to work the way I did. After an email exchange, we found the source of the 
problem....

Andy writes:

Using TextEdit, I went into the preferences where, by default, the text format was Rich Text, 
and I changed it to Plain Text. After that I was able to copy and paste into FCP and the 
formatting was intact. 

Just for the heck of it I then tried copying and pasting from Adobe InDesign into FCP but it did 
not work. Copy from InDesign then paste into TextEdit then copy and paste into FCP and it 
does work. 



Larry adds: The reason is that all these other programs add hidden codes to help format your text. You don't 
see them, but they are carried in the clipboard when you copy the text. FCP doesn't understand these codes, 
so it doesn't know what to do about the text. So it ignore it.

To copy text into a Final Cut Pro clip, copy it from your source application, then paste it into a plain text 
document in Text Edit. Copy it again, which remove these hidden codes, and paste it into Final Cut.

Works great.
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SCROLLING TEXT JUMPS

Tamer Nagi writes:

I finally i got to Edit a short film for my friend but every time i do the scrolling text in FCP it's 
just jumping. friend of mine ask my to do it in live type, i did it but still jumping a little any idea 
why?

Larry replies: Sigh... this is an example of "just because you can, doesn't mean you should."

The problem is interlacing. This problem doesn't normally appear for progressive video. Back in "The Olde 
Days™" we had titling systems called Chyrons that had exactly two scroll speeds - somewhat-too-slow and 
way-too-fast - that we could use for credits. And the reason is that in order to avoid flickering, a title needs to 
move up exactly the height of a pixel between one frame and the next. If it moves any other distance, the 
text flickers.

The problem is that Final Cut does not give us any precise way to set the speed of a scroll, which means the 
only way to fix this problem is to spend a life-time tweaking the length of the scroll. Or, find a program that 
does this better: Video Tagger.
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STP KEYFRAMES AND ENVELOPES

Steve MacDonald writes:

Concerning your STP 2 training DVD, where you describe envelopes, you mention that STP 
will keep wanting to reset keyframes back to the original FCP audio settings. With that being 
said, wouldn't it be a waste of ones time to make minute audio tweaks within FCP if one is 
going to take that file to STP? I'm just making sure I'm understanding that part of the DVD 
correctly?

Larry replies: Rather let me say that when you send your FCP project to STP, all the keyframes you set in 
FCP travel with it. 

However, since STP applies effects and levels to the entire track, many times - but not always - it is easier to 
delete all the FCP keyframes and start from scratch.

In which case, yes, I believe you are generally wasting time messing with setting audio levels in FCP.
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http://www.electrichappiness.com/VideoTagger_Home.jsp


GETTING CENTERED

Lee Berger writes:

Here's a problem I've noticed for quite some time now and it's annoying. Sometimes when you 
select the Center Control in the Motion Tab, the marker appears way outside the viewable 
area in the canvas. Why is this and is there any way to correct it?

Larry replies: The Center determines where the center of the selected image will be located. 

For example, to move an image off-screen, you drag the Center far off screen. The only way this can be 
done is to change the scale of the Canvas window. 

Go to near the top of the Canvas window and click the first of three pop-up menus - the one with a 
percentage on it. 

Change the scale to something small, this reduces the size of the image displayed in the Canvas. (When the 
Scale is 100%, you are viewing the image at full size. If this Scale is 50%, you are viewing the image at half-
size. You are NOT changing the size of the image, simply the size you are viewing the image.

The gray area around the image is non-viewable space. You can drag an image there, but it won't be seen. 
Only images inside the black area will be visible. The white dot in the center of the image is the location of 
the Center point.
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POSITIVES AND NEGATIVES OF SSD DRIVES

Last month, Adam Connell wrote asking about my opinions on SSD (Solid-state drive) hard drives. At that 
time, I wrote: 

However, based on what I'm reading, at this point, SSD hard drives are designed for 
environments with a LOT of shaking and physical movement. At this point in time, SSD drives 
are slower and smaller than standard hard drives. And they are almost double the cost.

If you are bouncing across the wilds of America, recording to your computer which is strapped 
to the back of a bouncing jeep, then an SSD hard drive makes perfect sense.

However, if you are not in a high-abuse situation, stay with standard hard drives."

After that , Chris Paul sent me the following:

I have a current model 17" MacBook Pro with a 256 meg SSD. I have found that it has 3 
advantages not mentioned above:

1) Battery life. I get at least 8 hours of mixed use when running this laptop on battery, 
compared to 2-3 hours on my previous generation 15" MacBook Pro. I know that the newer 
model benefits from a bigger battery but I believe that the SSD makes a big difference as well. 
I never got the battery life that Apple claimed for my previous laptop but I do with this one.

2) Boot time. Booting up the OS from power off takes about 2 seconds. Booting up Final Cut 
takes about 3 seconds (plus reading any projects, which is also a lot faster). I get really 
spoiled by this and rather annoyed when I have to wait for my 8 core Intel Mac Pro to boot and 
launch apps.

3) Heat. The new laptop is quite tolerable on my lap, while the old model got too hot to handle 
with extended use.

I am considering putting a SSD boot drive in my next Mac Pro as the boot and app launching 
times are so much faster that it adds up to real time savings.

Larry adds: Thanks, Chris, for sending this in!
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PROBLEM WITH BOOT DRIVE

Jeff Overfield sent this in:

[ I'm getting error messages about my project being "unreadable" or "too new." ]. As far as 
what i did that may have/probably caused this issue:

i removed the final cut pro documents folder (waveform cache, autosaves, etc) from my 
computer when i was attempting to send my computer in for an overheating issue. luckily i 
didn't have to send it in, and have since returned the files to where they were at. when i tried 
to open, i started getting the unreadable message.

also, my computer, which is nicknamed "The Void" sometimes renames itself, i.e., "The Void 
(2)," and just renamed itself recently to "the Void (3)." not sure why this would be happening, 
but not sure if that would make FCP think it's not finding what its looking for in the right place 
also.

anything you could advise me on as far as how to confirm the user issue, or other suggestions 



would be greatly appreciated.

Larry replies: Jeff, the problem lies, I suspect, in the renaming of your boot drive. I've seen this happen on 
my own system, not with my boot drive, but with my second drive.

I'm not a programmer, so the developers in the audience will probably correct my simplistic approach to this, 
but the Mac operating system uses two file names for everything - one that you create and change and 
remains visible on the desktop; and a second one that the operating system uses to keep track of files, 
folders, and hard disks.

Some applications use the names you give things. Others use the hidden names of the operating system. 

The benefit to using the hidden name is that you can change the visible name and not break anything. 
Sometimes, though, when you connect two external drives with the same name - in my case, I connected 
two drives both named "2nd Drive," the OS has to rename one to prevent confusion.

So the visible name is changed to "2nd Drive [1]". The problem is that now, some applications can find files 
and other can't. This can mess up everything.

What you may want to do to fix this is connect your computer to another computer using a FireWire cable.

Restart your computer while holding the letter "T" down during startup. This turns your computer into a 
FireWire drive attached to the second computer.

Using a program like SuperDuper, copy EVERYTHING from your boot drive to another drive. SuperDuper 
copies all files on your hard drive, including invisible system files.

Then, when all data has been copied, erase your falsely-named boot drive and reset the name back to "The 
Void". 

Copy your data back, again, using SuperDuper. You will most likely need to rename everything, but that 
should fix the problem.

UPDATE - July 20, 2009

Eric Mittan adds: 

In response to Jeff Overfield's question about his computer renaming itself. I think there was 
some confusion. I DON'T believe that the computer is renaming it's own boot disk to include a 
(2) or (3), but the computer is renaming it's own network name, located under the sharing 
panel of System Preferences. The computer senses that another machine with the same 
name is already running on the network, and in order to avoid a conflict with an already 
existing bonjour name (thevoid.local) it renames itself to The Void (2). This can occur when 
you've got some funky networking setup, perhaps using hamachi a sort of VPN/Virtual LAN 
application. Or, it can happen if you're using both ethernet ports on your Mac Pro; one to 
connect to a house/internet line and the other to connect to a separate, private network, like 
an EditShare network. The collision occurs if, somewhere else in your connections, those two 
networks intersect via cable or switch (not via another machine). One of your ports sees the 
other port through the network and assumes it's another machine, causing the conflict and 
forcing the machine to rename itself.

I don't know if this necessarily solve's Jeff's problem, but when I saw his explanation, I knew 
immediately what he was talking about. This is a separate issue from a boot drive problem 
because if the above is occurring, the boot drive name stays the same.

Larry replies: Thanks, Eric. I am always nervouse when the solution calls for reformatting a hard disk. Your 
idea may be much more accurate. Thanks. 

[ Go to Top. ] 



PICKING THE BEST CODEC

Michael Cooper writes (and I am summarizing this):

I am currently in a class for After Effects and the professor suggested that to obtain the best 
quality master copy of our projects with minimal loss and good low file sizes we should create .
MOVs with the photo jpeg, animation or .h264.

Larry replies: I disagree with your professor. If you are not applying effects to a clip, FCP simply copies the 
source file during export, therefore no changes are made to the image. While Photo-JPEG is a good codec 
for editing, H.264 is not - H.264 absolutely degrades the image for editing.

The highest image quality you can get is the Animation codec. This is the best and only choice if you want 
high quality with transparency. If you just want high-quality, ProRes 422 is a better choice. It plays in real-
time (Animation most often does not) and the file sizes are smaller than Animation.

In general, if you are not applying effects, the highest quality you can get is the quality that you shot. For that 
reason, I recommend exporting from FCP using File > Export > QuickTime movie and settings set to Current 
Settings.
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EDITING MULTI-CAM

Brian Galford writes:

This is a question about trying to minimize the work my system has to do when editing a multi-
camera program.

I am currently editing a two-camera shoot, and I have not done a multicam edit because the 
two cameras are not of the same frame size or resolution. (I make this unlikely pairing work by 
setting the sequence to the lower frame-size-setting, and then adjust the higher-frame size 
camera to a fraction of its size and letting the distort section in the Motion tab do its aspect 
ratio computation. Perhaps more on that later, if anyone's interested.) So the way I edit this is 
old-fashioned: i simply stack both cameras' video and audio layers atop each other, and use 
the razor function to cut into the top layer whenever I want to see the bottom layer/camera. 

My question is this: when there are long periods of a minute or more of just the top layer/
camera's view being shown, is it doing any favors to the system to carve away the portion of 
the bottom layer which are obscured by the top layer? Or is it better to just leave it all intact? 
I'm thinking that if the system doesn't have to read two layers all the time it may be easier for 
it. What do you think?

Larry replies: If you are NOT using multicam, but simply stacking layers, there's no benefit to removing the 
bottom layer. Since the clip on V1 is totally blocked by the clip on V2, FCP ignores the clip on V1.

You can measure this using Activity Monitor. When two clips are stacked the data rate is equal to just one 
clip playing, FCP ignores the invisible clip underneath.
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FRAME RENDERING EXPLAINED

Jonathan Bewley asks:



When exporting in H264 DV, is Frame reordering recommended? I frankly don't understand 
what this feature does.

Larry replies: In general, leave this on. It reduces file size while maintaining quality.

In researching this, I read this on Apple's website: 

Some more advanced compressors use “frame reordering” to more efficiently represent movie 
data. Frame reordering is the concept of allowing frames to be decompressed in a different 
order than their display order. For almost all cases, leave this box checked for H.264 
encoding. The only time you would uncheck this box is if you are creating an H.264 movie that 
needs to be played back by an application that does not understand frame reordering, i.e., an 
application that does not yet use the new Frame Reordering APIs of QuickTime 7 or if 
someone asks you to create your content with “B-frames turned off.” If your audience will play 
back your movie with QuickTime 7 Player, you should leave the box checked.
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EXTERNAL FILTER CONTROLS 

Mike Palmer writes:

Larry, I have a question regarding control of plug-ins. Is it possible to use hardware to control 
the parameters of a plug-in?

I know that you can use hardware controllers to change parameters of AU plug-ins in Logic, 
etc. Is there anyway to do this with filters/generator parameters with the FxPlug architecture of 
Final Cut?

Larry replies: Mike, sort of...

You can connect an external audio interface to FCP which allows remote control of many, but not all, audio 
functions. However, on the video filter side, that kind of external control doesn't exist. It DOES for Motion, but 
not Final Cut.
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QUESTIONS LARRY NEEDS HELP WITH

Every month, I get questions for which I don't know the answers -- especially related to specific gear. Rather 
than let these languish, I figured I'd ask you for help. If you can answer any of these, please let me know. I'll 
post it here and send your comments back to the person that asked.

DETERMINING NETWORK TECHNICAL STANDARDS

Jorge writes:

Greetings from Idaho Falls. Quick question: Is there a place where I can find the broadcast 
production standards required by the major networks? I deal with different vendors each of 
whom thinks he has the right standards for video. The end result is audio references from –20 
to –3; a mix bag of video perspectives, etc. I’m attempting to standardize our requirements, 
but the first question, I’m sure, will be: “where did you get them?”

Larry replies: It has been about 18 months since I delivered a broadcast master, so I'm not current on my 



specs. Can anyone give us a hand with where these can be found?
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CAPTURING RGB 4:4:4 MEDIA

Paul Fiore sent me a question I can't answer. He writes:

Real Quick. What is the proper Easy Set up for capturing an HDSR 4:4:4 master to sustain 
that quality? I assure you all my dual link cabling and Kona 3 control panel set ups are in 
check, just not sure what Easy Set up to use once I get in FCP. 

I don't see one for 10-bit 4:4:4 - I read online the RGB set up is 4:4:4 - I've attached a scene 
grab. I think I've narrowed it done to 2 options.

Larry replies: Paul, it's only "Real Quick" if I know the answer. I don't, but if someone can suggest one, I'll 
post it here. My suspicion is that this isn't an Easy Setup, but one you need to customize in Audio/Video 
Preferences.
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PROBLEMS WITH THE PANASONIC HMC-151 

Mirko Pincelli asks:

I was used to work with the Panasonic HVX 200 for few years, importing exporting, everything 
worked fine. I now bought a PAL Panasonic HMC 151, one of the latest panasonic working 
with SD cards (any comments?). I am having problems with finding the right setting for my 
final cut studio 6.0.5. 

What is the best Audio Video setting you suggest to have for importing raw material made by 
this camera?

I was always used to export my file to Hi-Res and Low-Res after choosing portions of material 
I wanted to work with. I shoot 1080 50i The settings I used for exporting to Hi-Res are: AIC, 
frame rate 50, 1280x720 HD, deinterlace source switched on.

The main problem that I am having is that once i open the saved Hi-Res with final cut (the clip 
played with quick time plays fine) the clip plays slowly as a slow motion. Audio seams fine, but 
the video is playing visibly slow speed.

I believe that my workflow is not safe at all, what do you suggest for such a camera?

UPDATE - July 20, 2009

Ben Balser adds: 

Since this is AVCHD/H.264, I'd use Pro Res, rather than AIC. Just convert to Pro Res 422, 
and it should be fine. Pro Res, from what I understand, may handle the H.264 Long GOP 
better than AIC (which was made primarily for HDV MPEG-2 Long GOP).

Larry replies: Oops, I forgot. Thanks for reminding me. 

[ Go to Top. ] 



WORKING WITH CANON 5D MARK II

George Rindon asks:

Will you ever feature the best work flow for getting the best results when shooting with HD 
with the canon 5D Mark II camera?

UPDATE - July 20, 2009

Matt Davis sent this in:

I had the pleasure of filming Philip Bloom doing a presentation on the workflow at the UK FCP 
SuperMeet a few weeks ago, and it's now published on MacVideo.tv:

http://www.macvideo.tv

There's also Walter Murch and other goodies from that evening, but Philip's take on the EOS 
is great. And I think I'll be joining the EOS camp myself shortly.

Rick Jones continues: 

If you’re looking for workflow using FCP with the Canon 5DmkII, check out Philip Bloom’s 
forum. He is working on a series of videos on this topic via his F-Stop Academy.  
 
philipbloom.co.uk/2009/07/12/new-series-of-canon-5dmkii-tutorials/

Larry replies: Thanks, Matt and Rick. 
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GETTING A DSR 1800 TO WORK

Rick LeCompte writes:

I'm having a problem getting my Sony DSR 1800 DVCam deck to be recognized by my Final 
Cut. I just got a new Mac Pro. I never had a problem with the old G5 but the new computer will 
not see the deck. The DSR 1800 connects via a Firewire 400 cable. Since the MacPro only 
has Firewire 800, I got an 800 to 400 cable to connect. No luck. Then I installed a PCI 
Express card with a 400 port. Still no luck. The new 400 port does work since it recognizes an 
external Firewire drive when plugged in.

I found something online about deleting Quicktime Receipt files but there were none in the 
Receipts folder.

I called the FCP support line at Apple, but they were no help at all. Basically said "sorry". Do 
you have any ideas?

UPDATE - July 20, 2009

Frank Baker adds: 

The DSR-1800 has 2 buttons to press to enable firewire control. Facing the machine on the 
right side there are 3 buttons by the jog shuttle control. Make sure the I-link and remote 

http://www.macvideo.tv/camera-technology/features/index.cfm?articleId=119441
http://philipbloom.co.uk/2009/07/12/new-series-of-canon-5dmkii-tutorials/


buttons are both pressed and lit. Also for video input, I-link has its own button in the input 
select area. I've used this deck with FCP 5 & 6 with no issues however this was MB Pro with a 
firewire400 input.

Larry replies: Thanks, Frank. 

[ Go to Top. ] 

WRAP-UP

Well, that's about it for this month. 

For current news and in-depth interviews on what's happening in our industry, be sure to listen to the Digital 
Production BuZZ every week. In fact, you can put the free player on your website! 

�●     Visit our store and buy some of our latest tutorials. 
�●     Or, check out my latest video about picking the right HD format for your project. 

Also, please continue sending your comments and questions. I love hearing from you and enjoy the 
conversations that develop around these stories.

Until next month, take care, and edit well.

Larry

Subscribe to Larry's FREE

Monthly Newsletter! 

Email:    

 

[ Click here for a printer-friendly PDF version of this issue. 1.2 MB ]

Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends to sign up at 
www.larryjordan.biz/newsletter.

To unsubscribe, simply send me an email and I'll remove you from the list. This list is not sold, 
rented, or bartered. The only person who knows you are on this list is me.

The information in this newsletter is believed to be accurate at the time of publication. 
However, due to the variety of possible system and software configurations, the author 
assumes no liability in case things go wrong. Please use your best judgment in applying these 
ideas.

The opinions expressed in this newsletter are solely those of the author. This newsletter has 
not been reviewed or sanctioned by Apple or any other third party. All trademarks are the 
property of their respective owners and are mentioned here for editorial purposes only.

http://www.digitalproductionbuzz.com/LiveThisWeek
http://www.digitalproductionbuzz.com/LiveThisWeek
http://www.larryjordan.biz/training/online_tutorials.html
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=110
mailto:larry@larryjordan.biz?subject=Newsletter comments
http://www.larryjordan.biz/nxltrs/ljnxltr58.pdf
http://www.larryjordan.biz/nxlttrs.html


Text copyright 2009 by Larry Jordan & Associates, Inc. All rights reserved. This newsletter may 
not be reproduced or published in any way, in whole or in part, without specific written 
permission from the author. 

Links to my home page, blog, or website articles are welcome and don't require prior 
permission. 
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